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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Overview
Figure 1-1  HP Compaq All-in-One Business PC (model 8300 shown)

The HP Compaq All-in-One Business PC offers the following features:

● Integrated All-in-One form factor

● Full HD, LCD display (1920 x 1080) with LED backlighting

◦ 23-inch diagonal with optical touch

◦ 23-inch diagonal

◦ 21.5-inch diagonal

● Swivel pad under base of stand

● Adjustable tilt

● Optional height adjustable and reclining stand

● Removable panel on the back of the computer allows users or technicians to easily and
efficiently service the PC

● VESA mounting holes (100 mm x 100 mm)

● 2nd and 3rd generation Intel® Core™ processors

● Up to 2 TB hard disc drive, or up to 300 GB Solid State Drive
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● Optional Tray-load HP SuperMulti DVD+/-RW SATA Optical Disc Drive or DVD-ROM disc drive

● Optional mSATA module that can be used as a cache or SSD for the Elite 8300 or as a second
drive for the Pro 6300

● Intel Q77 Express chipset – Intel vPro (HP Compaq Elite 8300 All-in-One Business PC)

● Intel Q75 Express chipset (HP Compaq Pro 6300 All-in-One Business PC)

● Two SODIMM slots with up to 16 GB of DDR3 SDRAM memory and dual channel memory
support

● Intel integrated graphics

● DisplayPort video out (with audio) for second display support

● Optional MXM graphics card

● DP audio, DP to VGA/DVI/HDMI dongle support

● Integrated Gigabit Ethernet (Intel 82579 LM Gigabit Network Connection)

● Wireless connectivity (optional):

◦ Integrated 802.11 a/b/g/n or b/g/n wireless LAN module

◦ Bluetooth® 4.0

● Optional integrated full HD webcam and dual microphone array

● Premium stereo speakers

● Optional 6-in-1 media card reader

● 6 USB ports: 4 USB 3.0, 2 USB 2.0

● Choice of wired or wireless keyboard and mouse

◦ Wired USB keyboard and mouse

◦ Wired PS/2 keyboard and mouse

◦ Wireless keyboard and mouse

● Face Recognition for HP ProtectTools software with facial recognition auto-login capabilities
(with optional webcam)

● Windows® 7 Professional 32-bit or 64-bit operating system

● 90-percent energy-efficient power supply

● ENERGY STAR® qualified, EPEAT® Gold registered
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Front components
NOTE: Front components are the same for 6300 and 8300 models.

Figure 1-2  Front components

Table 1-1  Front components

Component Component

1 Webcam with privacy shutter (optional) 7 Mute speaker

2 Dual microphone array (with optional webcam) 8 Reduce volume

3 Webcam activity LED (with optional webcam) 9 Increase volume

4 16:9 widescreen LED-backlit LCD display 10 Mute microphone

5 Power LED 11 Decrease brightness

6 High-performance stereo speakers

NOTE: No speaker option available.

12 Increase brightness

Touch the icon area (7–12 above) to cause the icons to illuminate, then touch an icon to activate it.

To change the volume or brightness, touch and hold the appropriate icon or touch it and repeat until
the volume or brightness has reached the desired level.

To mute the speaker or microphone, just touch the appropriate icon. The icon remains illuminated
until you touch it again to reactivate the speaker or microphone.

NOTE: If you mute or reactivate the speaker in a software application, the icon illuminates or
darkens accordingly.

You cannot mute or reactivate the microphone from a software application.
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Side components
NOTE: Side components are the same for 6300 and 8300 models.

Figure 1-3  Side components

Table 1-2  Side components

Component Component

1 Hard disc drive activity LED 6 Tray-load optical disc drive

2 HP 6-in-1 media card reader (optional) 7 Optical disc drive eject button

3 (2) USB 3.0 ports 8 Optical disc drive activity LED

4 Microphone/line in jack 9 Power button

5 Headset/line out jack   
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Rear components
NOTE: Rear components are the same for 6300 and 8300 models.

Figure 1-4  Rear components

Table 1-3  Rear components

Component Component

1 Access panel 8 DisplayPort connector

2 Access panel latches 9 RJ-45 Gigabit Ethernet port

3 Security lock slot 10 Stereo audio line out

4 Power connector 11 Rear port cover

5 (2) PS/2 mouse and keyboard connectors 12 Serial port (optional)

6 (2) USB 2.0 ports 13 Access panel security screw

7 (2) USB 3.0 ports   
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2 Installing and customizing the software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

NOTE: If the computer was shipped with Windows 7 loaded, you will be prompted to register the
computer with HP Total Care before installing the operating system. You will see a brief movie
followed by an online registration form. Fill out the form, click the Begin button, and follow the
instructions on the screen.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the operating system
The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Downloading Microsoft Windows updates
1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on

the screen.

2. Once an Internet connection has been established, click the Start button.

3. Select the All Programs menu.
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4. Click on the Windows Update link.

In Windows 7, the Windows Update screen appears. Click view available updates and make
sure all critical updates are selected. Click the Install button and follow the instructions on the
screen.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or upgrading device drivers (Windows systems)
When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Accessing disk image (ISO) files
There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be
created and the software installed in order to get the most from your PC. The software and image file
names are:

● Corel WinDVD SD and BD – installation software for WinDVD – used to play DVD movies

● HP Insight Diagnostics OR Vision Diagnostics – software to perform diagnostic activities on your
PC

Protecting the software
To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive. Refer to the operating system or backup utility
documentation for instructions on making backup copies of your data files.

Installing or upgrading device drivers (Windows systems) 7
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3 Computer Setup (F10) Utility

Computer Setup (F10) utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, memory,
audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including USB, audio, or embedded NIC, so that they cannot
be used until they are unsecured.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Execute self-tests on a specified ATA hard drive (when supported by drive).
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Using Computer Setup (F10) utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom
of the screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and
again press Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File  > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings, select Apply Defaults and Exit. This option will restore the
original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-1  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2/L3)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tag

● ME firmware version

● ME Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup Save to Removable Media

Saves system configuration, including CMOS, to a formatted USB flash media device.

Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware version, serial number, SMART.

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are two supported options: AHCI and IDE.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

IDE - This is the most backwards-compatible setting of the two options. Operating systems usually
do not require additional driver support in IDE mode.

NOTE: The AHCI device driver must be installed prior to attempting to boot from an AHCI
volume. If you attempt to boot from an AHCI volume without the required device driver installed,
the system will crash (blue screen).

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which UEFI boot sources and legacy boot sources (such as a USB flash
media device, hard drive, optical drive, or network interface card) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or
included for consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

Press F5 to disable a device. Press Enter to select a device. Press the arrow keys to drag a
selected device.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 before the computer boots to the operating system. After POST is
completed, a list of bootable devices is displayed. Use the arrow keys to select the preferred
bootable device and press Enter. The computer then boots from the selected non-default device
for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Device Security Allows you to set Device Available/Device Hidden for:

● Embedded security device (some models)

● System audio

● Network controller

● SATA0

● SATA1

● SATA2

● SATA3

USB Security Allows you to enable or disable groups of USB ports or individual USB ports. Default is device
available.

● Front USB Ports

◦ USB Port 1

◦ USB Port 2

● Rear USB Ports

◦ USB Port 1

◦ USB Port 2

◦ USB Port 3

◦ USB Port 4

● Accessory USB Ports

◦ USB Port 1

◦ USB Port 2

◦ USB Port 3

◦ USB Port 4

◦ USB Port 5

◦ USB Port 6
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Table 3-3  Computer Setup—Security (continued)

Slot Security Allows you to disable or enable the PCI Express x1 slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only). Default is enable.

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data
stored on the disk. Master Boot Record Security may prevent unintentional or malicious changes
to the MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities.
It also allows you to recover the "last known good" MBR, should changes to the MBR be detected
when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the
BIOS cannot prevent changes that may occur while the operating system is running.
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Table 3-3  Computer Setup—Security (continued)

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
security breaches. Default is enabled.

Virtualization Technology (VTx/VTd) (some models) (enable/disable) - Controls the virtualization
features of the processor and virtualization DMA remapping features of the chipset. Changing this
setting requires turning the computer off and then back on. Default is disabled.

Intel TXT (LT) Support (some models) (enable/disable) - Controls the underlying processor and
chipset features needed to support a virtual appliance. Changing this setting requires turning the
computer off and then back on. Default is disabled. To enable this feature you must enable the
following features:

● Embedded Security Device Support

● Virtualization Technology

Embedded Security Device (some models) (enable/disable) - Permits activation and deactivation
of the Embedded Security Device. Changing this setting requires turning the computer off and
then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

OS management of Embedded Security Device (some models) (enable/disable) - This option
allows the user to limit operating system control of the Embedded Security Device. Changing this
setting requires turning the computer off and then back on. This option allows the user to limit OS
control of the Embedded Security Device. Default is enabled. This option is automatically disabled
if Trusted Execution Technology is enabled.

Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device. Changing this setting requires turning the computer off and then back
on. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Power

Option Description

OS Power
Management

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

● ACPI S3 Hard Disk Reset — Enable/disable. Enabling this causes the BIOS to ensure hard
disks are ready to accept commands after resuming from S3 before returning control to the
operating system.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern. Default is disabled.

◦ S0 (On) = Solid green LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

NOTE: If this feature is disabled, S4 and S5 both have the LED off. S1 (no longer
supported) and S3 use 1 blink per second.

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings—Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 1 Watt power usage. Default is disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Advanced

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot (default) = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No
more memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable). Default is disabled.

● Press the ESC key for Startup Menu (Enable/Disable). Default is enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Off—causes the computer to remain powered off when power is restored.

◦ On—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST
delay also gives you more time to select F10 to enter Computer (F10) Setup. Default is
None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made. Default is disabled.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.
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Table 3-5  Computer Setup—Advanced (continued)

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enable.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disable.

Device Options Allows you to set:

● Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.

● Printer mode (Bi-directional, EPP+ECP, Output Only). Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is on.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

● LVDS Panel Select (Auto-Select, LG, CMI, Samsung, AUO). Options differ based on model.
Allows you to specify the display panel manufacturer. Default is Auto-Select.

● Internal Speaker (some models) (does not affect external speakers). Default is enabled.

● NIC Option ROM Download (enable/disable). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1 MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. Default is-enable.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

VGA Configuration Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.

Management
Operations

Allows you to set:

● AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable,
the Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

● Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This
feature should be used with caution as AMT will not be able to provide any set AMT
management functions once unconfigured. Default is disabled.

● Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to
not display the confirmation to unconfigure ME.

● Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent to the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.
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4 Serial ATA (SATA) Drive Guidelines
and Features

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 7 32 GB 2 TB

NTFS ATA Windows 7 2 TB 2 TB
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5 Routine Care and Disassembly
Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage. 
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Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.
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● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the work area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors
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● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover removed.

● Do not place computers so near each other that they are subject to each other’s re-circulated or
preheated air.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.
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Routine Care

General cleaning safety precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case

Follow all safety precautions in General cleaning safety precautions on page 24 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 24 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
computer case on page 24.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions
on page 24 before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys. 

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.
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● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the display

● Wipe the display screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the computer case on page 24.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the computer case on page 24.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and software requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.
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Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer. 

Hard drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic discharge information on page 21

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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6 Removal and Replacement Procedures
All-in One (AIO) Chassis

The following sections provide information about disassembling various components of the computer.

Procedures for disassembling both 6300 and 8300 models are the same unless noted.

Preparing to disassemble the computer
To avoid injury and equipment damage, always complete the following steps in order, when opening
the HP Pro All-in-One.

1. Remove all media (CD, DVD, etc.) from the computer.

2. Shut down the computer.

3. After the system has completely shut down, disconnect the power adapter from the back of the
computer.

4. Disconnect all other attached cables from the back of the computer.

5. Place the computer face down on a soft flat surface. HP recommends that you set down a
blanket, towel, or other soft cloth to protect the screen surface from scratches or other damage.

WARNING! Beware of sharp edges inside the chassis.
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Adjusting the tilt/swivel base
Tilt the computer forward up to -5 degrees or backward up to +30 degrees to set it to a comfortable
eye level.

Figure 6-1  Adjusting tilt

The tilt/swivel base has a swivel pad on the underside that allows you to swivel the computer up to
360 degrees left or right for the best viewing angle.

Figure 6-2  Adjusting swivel

28 Chapter 6   Removal and Replacement Procedures All-in One (AIO) Chassis



Height adjustable/recline stand (optional)
An optional stand may be purchased to allow

● height adjustment of 110 mm (4.3 inches)

● rotation from landscape to portrait position

● tilt backward up to +60 degrees

● recline to 30 degrees from the desktop

Figure 6-3  Height adjustable stand position options
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To install the height adjustable stand:

1. Insert the stand into the slots in the rear of the computer.

Figure 6-4  Installing the height adjustable stand

2. Install the screws that secure the stand to the computer.

Figure 6-5  Installing the height adjustable stand screws
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Removing the rear port cover
1. If a cable lock is installed on the rear of the unit, remove the lock.

2. Grasp the rear port cover, then pull it down and off the computer.

NOTE: Removing the rear port cover may require that you use a significant amount of force.

NOTE: If using forceful pressure on the ribs does not remove security cover, grip the exposed
edge of the security cover by the AC plug and pull it straight out.

Figure 6-6  Removing the rear port cover

Cable management cover
1. If the rear port cover is installed, remove the cover.

2. Route all peripheral cables through the stand opening and plug them into the appropriate ports
as needed.

3. Hold the cable management cover under the cables, align the cover hooks with the slots in the
stand, and then insert the cover and slide it down.

Figure 6-7  Installing the cable management cover
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Installing an access panel security screw
You may prevent access to internal components by securing the access panel. Screw a T15 tamper-
resistant Torx screw through the left latch of the access panel to prevent removal of the panel.

NOTE: Spare parts for the security screw or associated hardware are not provided.

Figure 6-8  Securing the access panel

Synchronizing the optional wireless keyboard or mouse
The optional wireless keyboard and mouse are easy to set up. Just remove the battery tabs on both
the keyboard and the mouse to activate the preinstalled batteries. Also, make sure the Power switch
on the bottom of the mouse is in the On position (the keyboard does not have a Power switch). Then,
turn on the computer and synchronize them as described below.

NOTE: For better mouse battery life and performance, avoid using your mouse on a dark or high-
gloss surface, and turn mouse power off when not in use.

To synchronize the wireless keyboard and mouse:

1. Make sure the keyboard and mouse are next to the computer, within 30 cm (1 foot) and away
from interference from other devices.

2. Turn on the computer.
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3. Insert the wireless receiver into a USB 2.0 port on the computer.

NOTE: Insert the wireless receiver into a USB 2.0 port that is separated from USB 3.0 devices.

Figure 6-9  Installing the wireless receiver

4. Make sure the Power switch on the bottom of the mouse is in the On position.

5. Press and release the Connect button on the bottom of the mouse. The blue activity LED from
the wireless receiver illuminates when the synchronization command has been received and
turns off when synchronization is complete.

6. Press and release the Connect button on the bottom of the keyboard. The blue activity LED from
the wireless receiver illuminates when the synchronization command has been received and
turns off when synchronization is complete.

Figure 6-10  Synchronizing the wireless keyboard and mouse

NOTE: If the procedure does not work, remove and then reinsert the wireless keyboard and mouse
receiver from the back of the computer and then synchronize the keyboard and mouse again. If
synchronization still does not work, remove and replace the batteries.
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Access panel
The computer has one main rear access panel that allows access to internal components.

To remove the access panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Slide the access panel latches toward the edges of the unit, then slide the access panel toward
the top of the computer until it slides off the unit.

Figure 6-11  Removing the access panel
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3. To replace the access panel, hold the panel at a 90-degree angle, place the top into the guides
in the chassis, and then press down to align it with the guides.

Figure 6-12  Replacing the access panel

NOTE: Align the bottom of the access panel with the notches on the outside edge of the
computer (1) when installing.

If an access panel sensor is installed, make sure the tab (2) on the bottom of the access panel
slides over the sensor (3) when replacing the access panel.

Figure 6-13  Access Panel Replacement

4. Push the access panel firmly into place until correctly seated.

To replace the access panel, reverse the removal procedures.
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Stand
The stand is secured with two captive Torx screws. You must remove a plastic cover to gain access
to the screws. You must remove the access panel to remove the stand.

To remove the stand:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Push the release button (1) on the bottom of the stand and pull the back of the stand off (2).

Figure 6-14  Removing the back of the stand

4. Push the base of the stand down (1), and loosen the two captive Torx screws securing the stand
to the chassis (2).

Figure 6-15  Releasing the stand

36 Chapter 6   Removal and Replacement Procedures All-in One (AIO) Chassis



5. Lift the stand up and off the computer.

Figure 6-16  Removing the stand

To replace the stand, reverse the removal procedures.
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Lower panel
The lower panel is located under the stand and on the bottom part of the computer.

Figure 6-17  Lower panel location

To remove the access panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the screw (1) in the middle of the lower panel, and detach the lower panel from the
chassis (2).

Figure 6-18  Removing the lower panel

To replace the lower panel, reverse the removal procedures.
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Metal plate
The metal plate is located under the stand.

Figure 6-19  Metal plate location

To remove the metal plate:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the two Torx screws (1) securing the metal plate to the chassis.

Metal plate 39



6. Slide the metal plate left to the left (2), and then lift it off the chassis (3).

Figure 6-20  Removing the metal plate

To replace the lower panel, reverse the removal procedures.
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Replacing drives

Replacing the hard disc drive with a 3.5-inch hard disc drive or a single
2.5-inch drive

The hard disc drive is located behind the access panel on the left side of the computer (when viewed
from behind). The drive is housed in a removable cage.

Figure 6-21  Hard drive location

If you choose to install an optional 2.5-inch solid state drive (SSD) or self-encrypting drive (SED), you
will need a drive adapter. The drive adapter is not included in the 2.5-inch SSD spare parts kits.

The first hard drive data cable connects to the SATA0 and SATA PWR0 system board connectors.

The second hard drive data cable connects to the SATA1 and SATA PWR1 system board
connectors.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).
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3. Pull the latch next to the lower side of the hard disc drive cage away from the cage to release it,
then slide the cage toward the edge of the chassis and lift it out.

Figure 6-22  Removing the hard disc drive cage

4. Lift the latch on one side of the hard disc drive cage and pull the hard disc drive out of the cage.

Figure 6-23  Removing the hard disc drive from the cage
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5. Remove the four mounting screws from the hard disc drive. Be sure to keep the blue rubber
grommets with each screw.

Figure 6-24  Removing the mounting screws

6. Screw the four mounting screws into the new hard disc drive. Be sure to keep the blue rubber
grommets behind each screw.

Figure 6-25  Inserting the mounting screws

NOTE: If you choose to install an optional 2.5-inch solid state drive (SSD) or self-encrypting
drive (SED), you must

1. mount the drive in a drive adapter

2. screw the four mounting screws into the drive adapter
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7. Slide the new hard disc drive, or drive adapter bracket holding an optional 2.5-inch drive, into the
cage until it snaps in place. Be sure that the connector on the hard disc drive is at the opening of
the cage.

Figure 6-26  Inserting the hard disc drive into the cage

8. With the hard disc drive connector facing toward the center of the chassis, place the hard disc
drive cage into the chassis and slide it toward the center until it snaps firmly into place.

NOTE: Make sure the hard drive is firmly seated in the connector. Failure to completely seat
the hard drive may result in the inability to install the access panel, as well as disk errors when
booting the computer.

Figure 6-27  Installing the hard disc drive cage

9. To replace the access panel, set the panel on the back of the computer, slightly above the stand,
and slide it down into place.

10. Reconnect the power cord and external devices.

11. Lock any security devices that were disengaged when the access panel was removed.

12. Turn on the computer.
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Replacing the optical disc drive

The optical disc drive is located above the hard disc drive on the left side of the computer (when
viewed from behind).

The optical drive data cable connects to the SATA2 and SATA PWR2 system board connectors.

NOTE: The drive bracket is not spared. When replacing an optical drive, remove the bracket from
the old drive and install it on the new drive.

Figure 6-28  Optical drive location

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).
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3. Lift the tab at the back of the optical disc drive enclosure to release the drive.

Figure 6-29  Removing the optical disc drive

NOTE: When replacing an optical drive, remove the bracket from the old drive and install it on
the new drive. The bracket is not spared.

4. Remove the two screws securing the optical disc drive bracket to the drive.

Figure 6-30  Removing the optical disc drive bracket
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5. Secure the optical disc drive bracket to the new drive with the two screws.

Figure 6-31  Attaching the optical disc drive bracket

6. Align the new optical disc drive with the opening in the side of the computer. Push the drive in
firmly until it snaps into place.

NOTE: The optical disc drive can be installed in only one way.

Figure 6-32  Installing the optical disc drive

7. To replace the access panel, set the panel on the back of the computer, slightly above the stand,
and slide it down into place.

8. Reconnect the power cord and external devices.

9. Lock any security devices that were disengaged when the access panel was removed.

10. Turn on the computer.
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Memory
Memory modules are located on the right side of the computer (viewed from behind). The computer
has two memory slots.

Figure 6-33  Memory module location

For proper system operation, the SODIMMs must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-10600 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 1-Gbit, 2-Gbit, and 4-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 SDRAMs; SODIMMs constructed with x4 SDRAMs are
not supported

NOTE: The system will not operate properly if you install unsupported SODIMM memory.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed. Refer to the following table to identify the SODIMM
channel locations.
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Table 6-1  Identifying SODIMM locations

Location System Board Label Channel

Lower Socket SODIMM1 Channel A

Upper Socket SODIMM3 Channel B

● The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

● The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. If one channel will have more memory
than the other, the larger amount should be assigned to channel A.

● The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

● In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.

There are two memory sockets on the system board located behind the memory access panel. To
remove or install memory modules:

To remove a memory module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Place the computer face down on a soft flat surface. HP recommends that you set down a
blanket, towel, or other soft cloth to protect the screen surface from scratches or other damage.

3. Remove the access panel (see Access panel on page 34).

4. To remove a memory module, press outward on the two latches on each side of the SODIMM
(1), then pull the SODIMM out of the socket (2).

Figure 6-34  Removing a memory module
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5. To install a memory module, slide the SODIMM into the socket at approximately a 30° angle (1),
then press the SODIMM down (2) so that the latches lock it in place.

Figure 6-35  Installing a memory module

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

The computer automatically recognizes the additional memory when you turn on the computer.
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Replacing the battery
The RTC battery is located near the memory modules under the memory access panel.

Figure 6-36  Battery location

The battery is located in the memory compartment. The battery that comes with the computer
provides power to the real-time clock. When replacing the battery, use a battery equivalent to the
battery originally installed in the computer. The computer comes with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60° C (140º F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).
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2. Remove the access panel (see Access panel on page 34).

The battery can now be seen on the lower right side of the fan.

Figure 6-37  Locating the battery

3. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

4. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up. Push the other edge down until the clamp snaps over the other edge of the
battery (2).

Figure 6-38  Removing and Replacing a coin cell battery (Type 2)
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Serial port
The serial port is located near the bottom of the computer below the hard drive. It is secured with one
Phillips screw.

Figure 6-39  Serial port location

To remove the serial port:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the lower panel (see Lower panel on page 38).

4. Remove the Phillips screw (1) that secures the port to the computer.

5. Slide the bottom of the port assembly to remove it from the tab in the computer (2).
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6. Remove the cable from its routing path (3), and remove the serial port assembly from the
computer.

Figure 6-40  Removing the serial port

To install the serial port, reverse the removal procedures.
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Webcam module
On products that ship with a webcam module, the module is located at the top of the computer
beneath the top panel. It is secured with two silver Phillips screws and has one connector.

The webcam module is optional.

Figure 6-41  Webcam module location

To remove the webcam module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).
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3. Remove the two Torx screws that secure the webcam module bracket to the computer.

Figure 6-42  Removing the webcam module

4. Rotate the assembly to gain access to the connector on the module, and then disconnect the
cable from the module.

Figure 6-43  Disconnecting the webcam module cable
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5. To remove the module from the bracket, remove the two Phillips screws that secure the module,
and then separate the module from the bracket.

Figure 6-44  Disconnecting the webcam module cable

To install a webcam module, reverse the removal procedures.
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Converter board
The converter board is located on the left side of the computer (viewed from behind) under the main
rear cover. It is secured with two Torx screws and has two connectors.

Use the same converter spare part for all display panels; however, you must change jumper settings
on the board based on the display panel.

Figure 6-45  Converter board location

To remove the converter board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Disconnect the two cables from the board (1).

NOTE: Be careful not to damage the cables when disconnecting them from the board. Do not
pull on the wires.
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4. Remove the two black Torx screws (2) that secure the board to the computer.

Note the converter board jumper settings stamped on the chassis (3). Be sure to correctly
position the jumpers on the converter board for the installed display panel.

Figure 6-46  Removing the converter board

5. Lift the converter board from the computer.

Be sure to correctly position the jumpers on the converter board for the installed display panel,
as follows:

CAUTION: Incorrect jumper placement can result in damage to the converter board and
display panel.

● 21.5-inch panel

◦ AUO panel: pins (1)(2)

◦ CMI panel: pins (3)(4)

◦ LG panel: pins (7)(8)

● 23.0-inch panel

◦ CMI panel: pins (5)(6)

◦ LG panel: pins (9)(10)

◦ Samsung panel: pins (11)(12)
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21.5-inch

23.0-inch

To install the converter board, reverse the removal procedures.
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Touch sensor board
NOTE: The touch sensor board is located on the right side of the computer (viewed from behind)
above the system board. It is secured with one Torx screw and has three connectors.

Touch sensor boards are spared with the touch panel spare part kit. Be sure to replace the touch
sensor board when replacing a touch display panel.

Figure 6-47  Touch sensor board location

To remove the touch sensor board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Disconnect the cables from the three connectors on the board (1).

NOTE: Be careful not to damage the cables when disconnecting them from the board. Do not
pull on the wires or cables.
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4. Remove the Torx screw (2) that secures the board to the computer.

Figure 6-48  Removing the touch sensor board

5. Lift the touch sensor board from the computer.

To install the touch sensor board, reverse the removal procedures.
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Heat sinks – Graphics board and processor
Separate heat sinks cool the discrete graphic board (select models only) and the processor. If
installed, you must remove the smaller graphics heat sink before you can remove the larger
processor heat sink.

The graphics heat sink is secured with three Torx screws – two captured, one not captured. The heat
sinks share the one non-captured screw.

The processor heat sink is secured with five Torx screws – four captured, one shared, not captured.

Model 8300 may include a fan attached to the heat sink.

Figure 6-49  Heat sink locations

Graphics heat sink

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the center access panel (see Access panel on page 34).

3. Remove the black Torx screw from the top of the heat sink (1).
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4. Loosen the two silver captive Torx screws on the heat sink (2), and then lift the heat sink out of
the computer (3).

CAUTION: Remove heat sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

Figure 6-50  Removing the graphics heat sink

To replace the heat sink, reverse the removal procedures.

Processor heat sink – model 6300

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the center access panel (see Access panel on page 34).

3. If installed, remove the graphics heat sink (see Graphics heat sink on page 63).
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4. In the order indicated on the heat sink, loosen the four silver captive Torx screws (1) – (4), and
then lift the heat sink out of the computer (5).

CAUTION: Remove heat sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

Figure 6-51  Removing the processor heat sink — 6300 models

To replace the heat sink, reverse the removal procedures.

Processor heat sink – model 8300

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the center access panel (see Access panel on page 34).

3. If installed, remove the graphics heat sink (see Graphics heat sink on page 63).

4. In the order indicated on the heat sink, loosen the four silver captive Torx screws (1) – (4), and
then lift the heat sink out of the computer (5).

CAUTION: Remove heat sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.

5. Remove the non-captive Torx screw from the top of the heat sink (5).
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6. Lift the heat sink assembly from the computer (6).

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

Figure 6-52  Removing the processor heat sink — 8300 models

7. If you need to remove the fan from the heat sink, remove the three small Phillips screws that
secure the fan to the heat sink, and lift the fan from the heat sink.

Figure 6-53  Removing the fan from the heat sink

To replace the heat sink, reverse the removal procedures.
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Processor
1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the graphics heat sink (see Graphics heat sink on page 63).

4. Remove the processor heat sink (see Processor heat sink – model 6300 on page 64).

5. Rotate the locking lever to its full open position (1).

6. Raise and rotate the microprocessor retainer to its fully open position (2).

7. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 6-54  Removing the processor

To install a new processor:

1. Place the processor in its socket and close the retainer. Make sure the slot in the processor fits
into the post on the socket.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.
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3. If reusing the existing fan sink, clean the bottom of the fan sink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the fan sink you must clean the top of the processor and the
bottom of the fan sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the fan
sink atop the processor.

5. Go to step 7.

6. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

7. Secure the fan sink to the system board and system board tray.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the fan sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www.hp.com/support.

mSATA Solid-State Drive
The mSATA SSD is located on the bottom of the system board. The drive is secured with two Phillips
screws.

NOTE: In the following image, the mSATA SSD is not shown.

Figure 6-55  mSATA SSD location
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To remove the mSATA SSD:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the two Phillips screws that secure the SSD to the computer.

4. Lift the SSD to a 45-degree angle, and then pull it away to remove it from the socket.

To install the mSATA SSD, reverse the removal procedures.

NOTE: mSATA SSD are designed with a notch to prevent incorrect insertion.

WLAN module
The WLAN module is located on the left side of the system board. The module is secured with one
Phillips screw and has two connected antennas.

NOTE: The procedure to replace the WLAN module must be performed by an HP technician.

Figure 6-56  WLAN module location

To remove the WLAN module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).
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4. Remove the lower panel (see Lower panel on page 38).

5. Remove the metal plate (see Metal plate on page 39).

6. Disconnect the antenna cables from the module (1).

7. Remove the Phillips screw (2) that secures the module to the computer.

Figure 6-57  Removing the WLAN module screw and antennas
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8. Lift the module to a 45-degree angle (1), and then pull it away to remove it from the socket (2).

Figure 6-58  Removing the WLAN module

To install the WLAN module, reverse the removal procedures.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
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Graphics board
The graphics board is secured with two Torx screws. Removing it allows access to the webcam and
allows you to remove the main rear cover.

Figure 6-59  Graphics board location

To remove the graphics board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the graphics heat sink (see Graphics heat sink on page 63).

4. Remove the two Phillips screws (1) that secure the board to the system board.
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5. Rotate the board upward (2), and then pull it up and away from the connector to remove it from
the computer (3).

Figure 6-60  Removing the graphics board

To replace the graphics board, reverse the removal procedures.
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Speakers
On products that ship with speakers, the speakers are located at the bottom of the computer. Two
separate speakers are each secured by two Torx screws. To remove the right speaker you have to
remove the power supply plug.

Speakers are optional.

Figure 6-61  Speaker location

To remove the speakers:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove Torx screw that secures the power connector to the computer, and lift the connector
from its position on top of the left speaker (1).

6. Remove two Torx screws (2) that secure each speaker to the computer.

7. Disconnect the speaker cables from the system board connector labeled SPKR(3).

Figure 6-62  Removing the speakers

8. Remove the speakers from the computer.

To install the speakers, reverse the removal procedures.
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Fan
The fan is located near the middle of the computer and is secured with three Torx screws. You have
to remove the metal plate to remove the fan..

To remove the fan assembly:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the metal plate (see Metal plate on page 39).

6. Disconnect the fan cable from the system board connector labeled CHFAN (1).

7. Remove the three Torx screws that secure the fan to the computer (2).

8. Remove the fan from the computer (3).

Figure 6-63  Removing the fan

To install the fan assembly, reverse the removal procedures.

NOTE: To avoid damaging the rubber screw grommets installed around the captive screws, when
installing the fan, push down on the fan assembly before you tighten the screws. Make sure the
grommets are positioned correctly before tightening the screws.
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Side panels
The side panels are located one each side of the computer. They are secured with tabs, and the
removal procedures are similar for both panels.

Figure 6-64  Side panel locations

To remove the side panels:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the optical drive (see Replacing the optical disc drive on page 45).

6. Push the side panel out from the bottom (1).
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7. Rotate the panel out and off of the computer (2).

NOTE: The removal and replacement procedures are similar for both panels.

Figure 6-65  Removing the side panels (left side shown)

To install the side panels, reverse the removal procedures.
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Power supply
The power supply is located at the middle, bottom of the computer. It is secured with two Torx
screws. The power connector mounts separately with one Torx screw. The power supply slides out of
the bottom of the bracket that secures it.

Figure 6-66  Power supply location

To remove the power supply:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).
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5. Remove the Torx screw (1) that secures the power connector to the computer, and then lift the
connector from atop the speaker (2).

Figure 6-67  Removing the power connector

6. Disconnect the cable from the system board connector (1).

7. Position the cable above the power supply (2).

Positioning the cable above the power supply makes it easier to slide the power supply
downward and out of the bracket that secures it.

Figure 6-68  Removing the power supply
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8. Slide the power supply downward and out of the bracket that houses it.

Figure 6-69  Sliding the power supply out of the housing

To install the power supply, reverse the removal procedures.
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System board
The system board is located on the right side of the computer (viewed from the rear). It is secured
with eight Torx screws.

To remove the system board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the memory modules (see Memory on page 48).

6. Remove the graphics heat sink (see Graphics heat sink on page 63).

7. Remove the processor heat sink (see Processor heat sink – model 6300 on page 64).

8. Remove the processor (see Processor on page 67).

9. Remove the WLAN module (see mSATA Solid-State Drive on page 68).

10. Disconnect all cables from the system board, noting their location for reinstallation.
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11. Remove the cable mounting bracket by removing the Torx screw (1), and then sliding it up (2)
and lifting it out of the computer.

Figure 6-70  Removing the cable mounting bracket

12. On model 6300, remove the eight Torx screws (1) that secure the system board to the computer.

On model 8300, remove the ten Torx screws that secure the system board to the computer.

NOTE: Model 6300 shown in the following image.

13. Position the cables on the left side of the board out of the way (2) so you can freely slide the
board out of the computer.

NOTE: To allow the system board to slide up so you can remove it, you must place the cables
in the cable retention areas built into the chassis to the left of the system board. Failure to move
the cables out of the way will impede system board removal.
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14. Slide the system board toward the top of the computer (3), and then lift up the board from left
side to prevent interference between the side I/O bracket with the I/O ports on board.

Figure 6-71  Removing the system board (model 6300 shown)

To install the system board, reverse the removal procedures.

Replace the thermal pad below the system board.
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When replacing the system board, be sure to route the cables correctly. See the following images for
cable routing.

Route the following cables from under the system board cable mounting bracket:

● Display (LVDS)

● Optical drive data (SATA)

● Optical drive power

● Converter board
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Route the following cables from under the power supply:

● Power button board

● Hard drive data (SATA)

● Hard drive power

● Hood sensor
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Updating SMBIOS Information

When replacing the system board, you must reprogram the SMBIOS information on the affected
computer. Failure to reprogram the board will result in eventual failure, such as an activation failure
(need to reactivate the system) or a system recovery failure.

To update SMBIOS information in Computer Setup:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom
of the screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and
again press Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. Go to Security > System ID’s.

5. If necessary, press Ctrl+A to initiate edit mode.

6. Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and
cannot be edited.

System ID Setup Page

Setup Field Name Comment Label

Product Name Enter the Model name/number or marketing name. Flexbuild

Serial Number Enter the Serial Number of Unit. Support

SKU Number Enter the SKU or Product Number including Localization Code. Support

Asset Tag Enter the 18-byte identifier assigned to the computer. Support

Feature Byte Enter the Feature Byte string. The feature byte string is case sensitive.

The label includes spaces after every four characters. You can enter or
ignore these spaces – their only purpose is to help with data entry. There is
a character limitation of 40 bytes per line. When you reach this limit, go to
the next line to continue data entry. BIOS ignores the spaces and lines.

If you make an error during data entry, the data will not validate, and the
computer asks you to correct your data input.

Flexbuild

Build ID The Build ID of the unit. Flexbuild
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Card reader board
The card reader board is located on the right side of the system board. It is secured with two screws.

Figure 6-72  Card reader board location

To remove the card reader board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).
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3. Remove the two Phillips screws (1) that secure the board to the system board.

Figure 6-73  Removing the card reader board screws

4. Lift the board to a 45-degree angle (1), and then pull it away to remove it from the socket (2).

Figure 6-74  Removing the card reader board

To install the card reader board, reverse the removal procedures.

88 Chapter 6   Removal and Replacement Procedures All-in One (AIO) Chassis



Power button board
The power button board is located on the bottom left corner of the computer. It is covered by a Mylar
shield and has two connectors and one screw.

Figure 6-75  Power button board location

To remove the power button board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the optical drive (see Replacing the optical disc drive on page 45).

6. Remove the left side panel (see Side panels on page 76).
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7. Remove the Torx screw (1) that secures the Mylar that covers the power button board, and then
lift the Mylar from the computer (2).

NOTE: On some models, the left screw that secures the left speaker (when viewed from the
rear) may also secure the Mylar.

Figure 6-76  Removing the Mylar shield
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8. Disconnect the two cables (1) from the board, and then remove the Torx screw that secures the
board to the computer (2).

Figure 6-77  Removing the power button board

9. Remove the power button board from the computer.

To install the power button board, reverse the removal procedures.
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Front bezel
The front bezel is located on the front of the computer and is secured to the main system bracket with
eight Torx screws.

Replacement bezels include the webcam shutter and capacitive sensor board. On models that do not
include a webcam, you must remove the shutter and install the webcam insert (Webcam assembly
kit) into the slot in which the webcam would otherwise be installed.

To remove the front bezel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the optical drive (see Replacing the optical disc drive on page 45).

6. Remove the metal plate (see Metal plate on page 39).

7. Remove the power supply (see Power supply on page 78).

8. Remove the side panels (see Side panels on page 76).

9. Remove the speakers (see Speakers on page 74).

10. Remove the power button board (see Power button board on page 89).

11. Lift the bracket from the bottom-left side of the computer.

Figure 6-78  Removing the bracket
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12. Remove the Torx screws that secure the bezel to the main system bracket assembly, as follows:

● Model 6300: 11 total screws

◦ Left: 2 screws

◦ Top: 4 screws

◦ Right 2 screws

◦ Bottom: 2 screw

Figure 6-79  Front bezel assembly screw locations – 6300 models

● Model 8300: 14 total screws

◦ Left: 4 screws

◦ Top: 4 screws
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◦ Right 4 screws

◦ Bottom: 2 screw

Figure 6-80  Front bezel assembly screw locations – 8300 models

13. Lift the bracket from the bezel.

To install the front bezel, reverse the removal procedures.
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Antenna
The antenna route from the WLAN card to the top of the computer.

To remove the antenna:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the optical drive (see Replacing the optical disc drive on page 45).

4. Remove the stand (see Stand on page 36).

5. Remove the lower panel (see Lower panel on page 38).

6. Remove the metal plate (see Metal plate on page 39).

7. Remove the power supply (see Power supply on page 78).

8. Remove the side panels (see Side panels on page 76).

9. Remove the speakers (see Speakers on page 74).

10. Remove the system board (see System board on page 81).

11. Remove the front bezel (see Front bezel on page 92).
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12. Remove the two Torx screws that secure each antenna to the frame.

Figure 6-81  Removing the antenna

Figure 6-82  Removing the antenna
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13. Note the routing path for each antenna for replacement.

Figure 6-83  Antenna routing paths

To install the antenna, reverse the removal procedures.

Display panel
Model 6300 offers three different display panels – LG, AUO, and CMI.

Model 8300 offers three different display panels – LG, Samsung, and CMI.

Display panels require a backlight cable specific to the manufacturer. Make sure you use the
backlight cable packaged with the display panel.

The display panel is secured to the base pan with four Torx screws.

To remove the display panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the optical drive (see Replacing the optical disc drive on page 45).

4. Remove the stand (see Stand on page 36).

5. Remove the lower panel (see Lower panel on page 38).

6. Remove the metal plate (see Metal plate on page 39).
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7. Remove the power supply (see Power supply on page 78).

8. Remove the speakers (see Speakers on page 74).

9. Remove the side panels (see Side panels on page 76).

10. Remove the front bezel (see Front bezel on page 92).

11. Disconnect the backlight cable from the display panel.

NOTE: Replace the backlight cable with the new backlight cable that comes with the new
display panel kit.

Remove the backlight cable from the defective panel before sending the panel back to the
supplier.

Figure 6-84  Disconnecting the backlight cable from the display panel
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12. Model 6300: Remove the four Torx screws that secure the display panel to the frame. The screw
locations for each manufacturer are stamped into the metal.

The LG (1) and AUO (2) panels are secured with two screws on each side (left and right).

Figure 6-85  Display panel screw locations – 6300 models – LG or AUO panel

The CMI panel is secured with two screws on top, two screws on the bottom.

Figure 6-86  Display panel screw locations – 6300 models – CMI panel

- or-
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13. Model 8300: Remove the four Torx screws that secure the display panel to the frame. The screw
locations for each manufacturer are stamped into the metal.

The LG (1) and AUO (2) panels are secured with two screws on each side (left and right).

Figure 6-87  Display panel screw locations – 8300 models – Samsung or LG panel

The CMI panel is secured with two screws on top, two screws on the bottom.

Figure 6-88  Display panel screw locations – 8300 models – CMI panel

14. Lift the display panel from the frame.
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15. Disconnect the display cable from the display panel by pressing in on the tabs (1) on the side of
the connector, and pulling the cable from the connector (2).

Figure 6-89  Disconnecting the display cable from the display panel

Be sure to correctly position the jumpers on the converter board for the installed display panel, as
follows:

CAUTION: Incorrect jumper placement can result in damage to the converter board and display
panel.

● 21.5-inch panel

◦ AUO panel: pins (1)(2)

◦ CMI panel: pins (3)(4)

◦ LG panel: pins (7)(8)

● 23.0-inch panel

◦ CMI panel: pins (5)(6)

◦ LG panel: pins (9)(10)

◦ Samsung panel: pins (11)(12)
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21.5-inch

23.0-inch

To install a display panel, reverse the removal procedures.

When replacing a touch display panel, be sure to route the ZIF cables through separate holes in the
frame so they correctly connect to the touch sensor board.
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Hood sensor
The hood sensor is located on the bottom left of the computer (when viewed from behind).

Figure 6-90  Hood sensor location

To remove the hood sensor:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

3. Remove the access panel (see Access panel on page 34).

4. Remove the stand (see Stand on page 36).

5. Remove the lower panel (see Lower panel on page 38).

6. Remove the side panels (see Side panels on page 76).

7. Remove the metal plate (see Metal plate on page 39).

8. Remove the power supply (see Power supply on page 78).

9. Remove the system board (see System board on page 81).

10. Remove the front bezel (see Front bezel on page 92).

11. Remove the display panel (see Display panel on page 97).

12. Disconnect the hood sensor cable from the system board connector labeled HSENSE.
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13. Remove the cable from its routing path.

Figure 6-91  Hood sensor cable routing path

14. Slide the hood sensor out of its slot built into the chassis.

NOTE: the hood sensor fits tightly into the slot. Removal may require a flat-blade screwdriver
to help disengage it.

Figure 6-92  Removing the hood sensor

To install the hood sensor, reverse the removal procedures.
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Hard drive and optical drive cables and connectors
The hard drive and optical drive connectors are located near the middle of the computer, partially
under the main display bracket. Each connector is secured with two Torx screws and has two cables
that connect to the system board.

The optical drive connector cables are longer than the hard drive connector cables.

Figure 6-93  Hard drive cable and optical drive cable location

To remove the hard drive or optical drive connector:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 34).

3. Remove the stand (see Stand on page 36).

4. Remove the lower panel (see Lower panel on page 38).

5. Remove the side panels (see Side panels on page 76).

6. Remove the metal plate (see Metal plate on page 39).

7. Remove the power supply (see Power supply on page 78).

8. Remove the system board (see System board on page 81).

9. Remove the front bezel (see Front bezel on page 92).

10. Remove the display panel (see Display panel on page 97).

11. Remove two Torx screws that secure the hard drive connector or the optical drive connector to
the computer.

12. Remove the cables from the metal clips built into the computer.
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13. Disconnect the hard drive cables or the optical drive cables from the system board.

NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull
on the wires.

14. Remove the connector from the computer.

Figure 6-94  Removing the hard drive or optical drive connectors

To install the hard drive or optical drive connector, reverse the removal procedures.
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7 Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette
drive, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 134.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.
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Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table 7-1  Solving general problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date
and time). If the problem persists, replace the RTC battery.
See the Removal and Replacement section for instructions
on installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start > All
Programs > Accessories > Run and type msconfig.
On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open computer and check that the power button board
cable is properly connected to the system board.

3. Check that power supply cables are properly connected
to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button board.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving power problems
Common causes and solutions for power problems are listed in the following table.

Table 7-2  Solving power problems

Computer powered off automatically and the Power LED flashes red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

Power LED flashes red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Check if a device is causing the problem by removing
ALL attached devices. Power on the system. If the
system enters the POST, then power off and replace
one device at a time and repeat this procedure until
failure occurs. Replace the device that is causing the
failure. Continue adding devices one at a time to ensure
all devices are functioning properly.

2. Replace the power supply.

3. Replace the system board.

Solving hard drive problems

Table 7-3  Solving hard drive problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. Right-click Start, click Explore, and right-click on a
drive. Select Properties then select the Tools tab.
Under Error-checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.
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Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

Right-click Start, click Explore, and right-click on a drive.
Select Properties then select the Tools tab. Under Error-
checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving hardware
installation problems on page 122 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

System files missing or not properly installed. 1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.
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Table 7-3  Solving hard drive problems (continued)

Nonsystem disk/NTLDR missing message.

Cause Solution

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board dark blue SATA connector.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 134 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the
enclosure frame or the hard drive is not fully seated in the
carrier.

Push the carrier into the enclosure frame so that the
connector on the rear of the frame is properly seated. If this
does not solve the problem, turn off the computer, remove
the carrier, and check to see if the connector on the hard
drive is properly seated in the carrier.
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The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has
been activated.

Shut down the computer and contact HP for a replacement
enclosure.

Solving media card reader problems

Table 7-4  Solving media card reader problems

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open Computer, right-click on the corresponding drive icon,
and select Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing
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After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table 7-5  Solving display problems

Blank screen (no video).

Cause Solution

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Blank screen and the power LED flashes red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes red six times, once every second, followed by a two second pause, and the
computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

1. Check the supported monitor resolution.

2. Install the video drivers included in the upgrade kit.

3. Before hardware replacement, try to isolate further to
make sure issue is not software related.

Graphics card is bad. Replace the graphics card.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.
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Table 7-5  Solving display problems (continued)

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Driver issue. 1. Reboot.

2. Verify the correct drivers are installed for graphics.

Monitor issue. Check the monitor on a different computer to verify whether
the issue is with the monitor.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the symbol
from the Character Map into a document.

Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table 7-6  Solving audio problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.
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Table 7-6  Solving audio problems (continued)

Sound does not come out of the speaker or headphones.

Cause Solution

Digital CD audio is not enabled. Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table 7-7  Solving printer problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.
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Table 7-7  Solving printer problems (continued)

Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.

Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table 7-8  Solving keyboard problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. Click Start, click the arrow on the lower right corner of
the Start menu, then select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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Table 7-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/
keyboard, or no function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard
USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Solving keyboard and mouse problems 121



Solving hardware installation problems
You may need to reconfigure the computer when you add or remove hardware. If you install a plug
and play device, Windows automatically recognizes the device and configures the computer. If
you install a non–plug and play device, you must reconfigure the computer after completing
installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the
instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table 7-10  Solving hardware installation problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 must always be installed. DIMM1 must
be installed before DIMM3.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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Power LED flashes red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 must always be installed. DIMM1 must
be installed before DIMM3.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Solving hardware installation problems 123



Solving network problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table 7-11  Solving network problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Saving.

S5 Wake on LAN is disabled. : Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. 1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.
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Table 7-11  Solving network problems (continued)

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.
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New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

Table 7-12  Solving memory problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 socket. Ensure that a memory module is installed in the DIMM1
socket on the system board. This socket must be populated
with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. ECC and non-ECC memory modules cannot
be mixed.
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Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving processor problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Table 7-13  Solving processor problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support the TXT feature
previously enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table 7-14  Solving CD-ROM and DVD problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup. Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.
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Table 7-14  Solving CD-ROM and DVD problems (continued)

System will not boot from CD-ROM or DVD drive.

Cause Solution

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving hardware
installation problems on page 122 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.
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Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table 7-15  Solving USB flash drive problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.
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USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Solving internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table 7-16  Solving internet access problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)
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Table 7-16  Solving internet access problems (continued)

Unable to connect to the Internet.

Cause Solution

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

1. Select Start > Control Panel.

2. Click on Hardware and Sound.

3. Click on Device Manager.

4. Double-click Modems.

5. Select the modem.

6. On the General tab, click Diagnostics.

7. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving software problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table 7-17  Solving software problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 134 to determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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8 POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table 8-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM checksum. 1. Verify the correct ROM.

2. Flash the ROM if needed.

3. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 146.)

4. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 146.)

2. Replace the system board.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.

163-Time & Date Not Set Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly
installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.
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Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.
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Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card
(if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 146.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest
BIOS image.

511-CPU, CPUA, or CPUB Fan not
Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

514-CPU or Chassis Fan not Detected CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.

2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.

660-Display cache is detected unreliable Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected Front audio connector has been detached
or unseated from motherboard.

Reconnect or replace front audio cable.

918-Front USB Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.
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Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

1151-Serial Port A Address Conflict
Detected

Both external and internal serial ports are
assigned to COM1.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 146.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict
Detected

Both external and internal serial ports are
assigned to COM2.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 146.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 146.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer
Setup, change Storage > Storage
Options > SATA Emulation to IDE, and
select File > Save Changes and Exit.
Reenter Computer Setup and select
Security > Drivelock Security. For each
listed Drivelock-capable SATA device,
ensure Drivelock is Disabled. Lastly,
change Storage > Storage Options >
SATA Emulation back to RAID and select
File > Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.
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Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the
computer, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBx execution MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.
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Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2204-Inventory error during MEBx execution BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBx execution MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed. Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file
properly.

1. Try a different USB key device for
provisioning.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2217-ME Firmware Version request failure ME firmware is not properly responding to
BIOS query for version information.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2218-ME Firmware Version should be
updated

ME firmware must be updated to match
current functionality contained in the system
BIOS.

1. Update to the latest ME firmware
version.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3. If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

1. Recreate the provisioning file using
third party management console
software.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.
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Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key
is not a valid version for the current ME
firmware.

1. Reboot the computer.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.

2230-General error during MEBx execution Error occurred during MEBx execution
which fails into the “General” grouping.
Status information displayed along with the
error provides further clarity into the failure.
MEBx handles transference of information
between the system BIOS and ME
firmware.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2231-ME error during MEBx execution Error occurred during MEBx execution
which fails into “ME” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2232-AMT error during MEBx execution Error occurred during MEBx execution
which fails into “AMT” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2233-HECI error during MEBx execution Error occurred during MEBx execution
which fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2239-ME image lock failure Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2240-ME image unlock failure Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

POST Numeric Codes and Text Messages 141



Table 8-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic
utilities.
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Interpreting POST diagnostic front panel LEDs
This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table 8-2  Diagnostic front panel LEDs and audible codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes
every two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the
mouse to wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heat sink/fan
assembly is not properly
attached to the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2. Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

3 Processor not installed
(not an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.
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Table 8-2  Diagnostic front panel LEDs and audible codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

4 Power failure (power
supply is overloaded).

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices. Power on
the system. If the system enters the POST,
then power off and replace one device at a
time and repeat this procedure until failure
occurs. Replace the device that is causing
the failure. Continue adding devices one at
a time to ensure all devices are functioning
properly.

3. Replace the power supply.

4. Replace the system board.

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace
the system board.

Red Power LED flashes
seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

7 System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest
BIOS image. See the “Boot Block
Emergency Recovery Mode” section of the
Desktop Management Guide for more
information.

2. Replace the system board.
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Table 8-2  Diagnostic front panel LEDs and audible codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

9 System powers on but is
unable to boot.

1. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

2. Replace the system board.

3. Replace the processor.

Red Power LED flashes
eleven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

11 The current processor
does not support a
feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10)
utility.

3. Reinstall the original processor.

Red Power LED flashes
eleven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

12 MXM thermal shutdown. 1. Clean the MXM graphics card heat sink.

2. Replace the MXM graphics card heat sink.

3. Replace the MXM graphic card.

System does not power on
and LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open rear cover and check that the power
button cable is properly connected to the
system board.

3. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button board and
cable. If the problem persists, replace the
system board.

4. Replace the AC adapter.
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9 Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 8 for information.
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Establishing a Setup or Power-on password
To establish the power-on or setup password features, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

3. Press the F10 key to enter Computer Setup.

4. To establish Setup password, select Security > Setup Password and follow the instructions.

– or –

To establish a Power-On password, select Security > Power-On Password and follow the
instructions on the screen

5. Before exiting, click File > Save Changes and Exit.
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Resetting the Setup and Power-on password
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3. Remove the access panel.

4. Locate the header and jumper labeled PSWD.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper.

6. Replace the jumper.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

10. Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 8
for information.
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Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P
during POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is
important to back up the computer CMOS settings before resetting them in case they are
needed later. Back up is easily done through Computer Setup. See Computer Setup (F10) Utility
on page 8 for information on backing up the CMOS settings.
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4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure 9-1  CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM).

5. Replace the computer cover or access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising
you that configuration changes have occurred. Use Computer Setup to reset any special system
setups along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 8.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B Specifications

8300 models
Table B-1  Specifications

Dimensions (with stand)

Height

Width

Depth

17.2 in

22.1 in

7.7 in

43.6 cm

56.2 cm

19.6 cm

Approximate Weight (with stand)
21.7 lb – 25.5 lbs 9.85 kg – 11.55 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (non-condensing)

Operating

Non-operating

10-90% at ambient

5-95% at ambient

10-90% at ambient

5-95% at ambient

Maximum Altitude (unpressurized)

Operating

Non-operating

0 - 10,000 ft

0 - 30,000 ft

0 - 3,048 m

9,144 m

Power Supply

Rated Voltage Range

Rated Line Frequency

100-240 V

50-60 Hz

Max Operating Power 230 W
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6300 models
Table B-2  Specifications

Dimensions (with stand)

Height

Width

Depth

16.8 in

20.5 in

7.7 in

42.6 cm

52.2 cm

19.6 cm

Approximate Weight (with stand)
19.5 lb – 22.2 lbs 8.83 kg – 10.08 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (non-condensing)

Operating

Non-operating

10-90% at ambient

5-95% at ambient

10-90% at ambient

5-95% at ambient

Maximum Altitude (unpressurized)

Operating

Non-operating

0 - 10,000 ft

0 - 30,000 ft

0 - 3,048 m

9,144 m

Power Supply

Rated Voltage Range

Rated Line Frequency

100-240 V

50-60 Hz

Max Operating Power 180 W
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A
access panel

removing 34
antenna

removing 95
audible codes 143
audio problems 117

B
battery

disposal 26
battery replacement 51
booting options

Full Boot 134

C
cable management cover 31
cable pinouts

SATA data 18
card reader board

removing 87
cautions

AC power 20
cables 26
electrostatic discharge 21
keyboard cleaning 24
keyboard keys 25

CD-ROM or DVD problems 128
cleaning

computer 24
mouse 25
safety precautions 24

CMOS
backing up 146
clearing and resetting 149

components
front 3
rear 5
side 4

computer cleaning 24
converter board

removing 58
country power cord set

requirements 152

D
display panel

removing 97

E
electrostatic discharge (ESD) 21

preventing damage 21
error

codes 134, 143
messages 135

F
fan

removing 75
features

overview 1
flash drive problems 130
flashing LEDs 143
front bezel

removing 92
front components 3

G
general problems 108
graphics board

removing 72
grounding methods 22

H
hard disc drive, replacing 41
hard drive

proper handling 26
SATA characteristics 18

hard drive connector
removing 105

hard drive problems 111
hardware installation problems

122
heat sink

removing 63
height adjustment 29
hood sensor

removing 103

I
installing

2.5-inch drive, single 41
3.5-inch hard disc drive 41
access panel security screw

32
battery 51
optical disc drive 45

Internet access problems 131

K
keyboard

cleaning 24
synchronizing wireless 32

keyboard problems 120

L
LEDs

blinking power 143
blinking PS/2 keyboard 143

lower panel
removing 38

M
Media Card Reader problems

114
memory module

removing 48
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memory problems 126
metal plate

removing 39
monitor problems 115
mouse

cleaning 25
synchronizing wireless 32

mouse problems 120
mSATA SSD

removing 68

N
network problems 124
numeric error codes 135

O
opening the computer 27
operating guidelines 23
optical disc drive

replacing 45
optical drive connector

removing 105
optical drive problems 128
overheating, prevention 23

P
password

clearing 146
power-on 146
setup 146

POST error messages 134
power cord set requirements

country specific 152
power problems 111
power supply 153, 154

removing 78
power-on password 146
printer problems 119
problems

audio 117
CD-ROM or DVD 128
flash drive 130
general 108
hard drive 111
hardware installation 122
Internet access 131
keyboard 120
Media Card Reader 114
memory 126
monitor 115
mouse 120

network 124
power 111
printer 119
processor 128
software 133

processor problems 128

R
rear components 5
rear port cover

removing 31
removal and replacement

procedures
access panel 34
All-in One chassis 27
antenna 95
card reader board 87
converter board 58
display panel 97
fan 75
front bezel 92
graphics board 72
hard drive connector 105
heat sink 63
hood sensor 103
lower panel 38
memory 48
metal plate 39
mSATA SSD 68
optical drive connector 105
power button board 89
power supply 78
preparing to disassemble the

computer 27
serial port 53
side panels 76
speakers 74
stand 36
system board 81
thermal module 63
touch sensor board 61
webcam module 55
WLAN module 69

removing battery 51
resetting

CMOS 146
password jumper 146

rotation 29

S
safety and comfort 107
safety precautions

cleaning 24
SATA

connectors on system board
18

data cable pinouts 18
hard drive characteristics 18

screws, correct size 25
security

access panel security screw
location 32

serial port
removing 53

service considerations 25
setup password 146
side components 4
side panels

removing 76
software

problems 133
servicing computer 25

spare part number
tamper-resistent wrench 25
Torx T-15 screwdriver 25

speakers
removing 74

specifications
computer 153

stand
removing 36

static electricity 21
swivel adjustment 28
synchronizing wireless keyboard

and mouse 32
system board

removing 81
SATA connectors 18

T
tamper-proof screws

tool 25
temperature control 23
thermal module

removing 63
tilt adjustment 28
tools, servicing 25
Torx T15 screwdriver 25
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touch sensor board
removing 61

V
ventilation, proper 23

W
Wake-on-LAN feature 124
webcam module

removing 55
WLAN module

removing 69
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